The SAS® System under Windows, Version 7

Jennifer Clegg and Gary Mehler, SAS Institute Inc., Cary, NC

ABSTRACT

Version 7 of the SAS System for Windows provides support for Windows 95 and Windows NT 4.0. With this version, the SAS System continues to improve in the areas of user interface, application integration, and setup. This paper discusses both new features and enhancements in these areas. Additionally, this paper also discusses the support provided by the SAS System for Windows NT.

INTRODUCTION

This paper provides an overview of Version 7. You should view this paper as an introduction but should refer to the SAS documentation for Version 7 for more details. Additionally, refer to “Introducing Release 6.12 of the SAS System for Personal Computers” for a summary of enhancements added in Release 6.12. Version 7 continues to provide incremental enhancements to the user interface of the SAS System. In order to create a Windows application that best utilizes the Windows feature set, we follow the GUI standards documented in The Windows Interface Guidelines for Software Design.

GUI FEATURES

GUI enhancements to the Version 7 SAS System continue the trend to provide a more native look and feel familiar to PC users. Some of the GUI features include a print preview utility, additional printing options, command bar enhancements, Program Editor enhancements, and Microsoft IntelliMouse™ support.

Print Preview

To see how the contents of a window will appear as printed output, select the window you want to preview and then select Print Preview from the File menu (or click the Print Preview tool bar button).

In the Print Preview window, you can use the Next and Previous buttons to navigate through the pages to be printed. The current page number and total number of pages are displayed at the bottom of the window. You can also magnify your view of the current page (by 100%) by clicking Zoom, or by simply clicking inside of the page. To reduce your view, click Zoom or inside of the page again.

In the Print Preview window, you can navigate by using the following shortcut keys:

<table>
<thead>
<tr>
<th>Key</th>
<th>Full Page mode action</th>
<th>Zoom mode action</th>
</tr>
</thead>
<tbody>
<tr>
<td>PgDn</td>
<td>Advance to next page</td>
<td>Scroll down on current page</td>
</tr>
<tr>
<td>PgUp</td>
<td>Back to previous page</td>
<td>Scroll up on current page</td>
</tr>
<tr>
<td>Ctrl-PgDn</td>
<td>none</td>
<td>Scroll right on current page</td>
</tr>
<tr>
<td>Ctrl-PgUp</td>
<td>none</td>
<td>Scroll left on current page</td>
</tr>
<tr>
<td>Ctrl-Home</td>
<td>Go to first page</td>
<td>Go to first page</td>
</tr>
<tr>
<td>Ctrl-End</td>
<td>Go to last page</td>
<td>Go to last page</td>
</tr>
</tbody>
</table>

The command, DLGPRTPREVIEW, can be used to invoke the Print Preview window.
Printing Options
The SYSPRINT option and FILENAME statement have been modified to become more consistent with how printers are identified today on PCs. Port names are no longer required. Instead, the printers are now identified using the printer name as recognized by the operating system. Continued support for the Release 6.12 format is provided as much as possible. The Release 6.12 syntax and the new Version 7 syntax is shown below.

Release 6.12
Options sysprint="port" [print mgr print name]"
Filename x printer "port";

Version 7
Options sysprint="printer name" [print–to-file filename]"
Filename x printer "printer name";

More improvements to printing include the addition of new options to provide programmatic control of settings previously available only in interactive dialogs. Below is a list of the new options:

- ORIENTATION Specifies orientation of printed output on paper
- LEFTMARGIN Specifies left margin for printed output
- RIGHTMARGIN Specifies right margin for printed output
- TOPMARGIN Specifies top margin for printed output
- BOTTOMMARGIN Specifies bottom margin for printed output
- PAPERSIZE Specifies size of paper used for printing
- PAPERSOURCE Specifies bin to use paper from
- DUPLEX Controls whether and how printed output is duplexed
- COPIES Specifies number of copies to print

Another improvement to printing is the addition of a Page Setup dialog from which you can interactively change orientation, margins, paper size, and paper source. This new dialog replaces the functionality for setting orientation and margins that was previously accessible from the Print Setup dialog. An important aspect of this change is that there is now one global setting for orientation and margins, rather than a different setting for each printer. This makes the SAS System more consistent with other Windows applications, in which orientation and margin settings are normally independent of the currently selected printer. The Page Setup dialog can be invoked by selecting Page Setup from the File menu, by clicking the Page Setup button on the Print Setup dialog, or by issuing the DLGPAGESETUP command.

 Toolbar and command bar support
The SAS System uses industry standard tools on the default toolbar. The Customize dialog provides a way for you to create custom toolbars. In this version the toolbar uses the flat style to be more consistent with other Windows applications. A snapshot of the new toolbar is shown on the next page.
The SAS System supports a command bar for easy entry of commands. In previous releases of the SAS System, commands were not preserved when exiting the SAS System. In Version 7 commands entered via the command bar are saved when exiting. The number of commands saved is configurable in the Preferences dialog. With the Preferences dialog you can also select whether to order the commands by most recently used.

Another new command bar feature is AutoComplete. With AutoComplete enabled the SAS System attempts to match characters as they are typed in the command bar with previously entered commands. If a match is found, the command will be completed in the command bar for you with the added portion of the command selected. You may press enter to execute this command or continue typing to finish your command. AutoComplete may be disabled in the Preferences dialog.

An additional enhancement to the toolbar and the command bar is support for resizing them. Many users have requested the ability to have a larger command bar area.

**Program Editor Enhancements**

The Program Editor continues to be enhanced to provide more native Windows editing capabilities. Some enhancements in this version include improved selection and AutoSave support.

Here is a list of changes related to text selection:

- Use the CTRL-DELETE key to delete the current word instead of the whole line.
- Use the ALT key as you hold down the mouse button and drag the mouse to select a rectangular block (or column) of text.
- Use the SHIFT key in combination with the mouse button to extend the selection of a text area. (You can use this feature only within the current page.)
- When copying text to the clipboard, the text stays selected in the SAS system after the copy has occurred.
- When pasting text into the SAS system when an area is marked, the marked text is replaced with the new text.

AutoSave support is now available in the Program Editor. The default interval for saving the contents of the Program Editor is 10 minutes. The interval is configurable in the Preferences dialog.

**IntelliMouse**

The SAS System provides support for the Microsoft IntelliMouse. The IntelliMouse is a modified mouse that includes a rotating wheel (wheel control) that enables new forms of navigation. The IntelliMouse is supported in windows within the SAS System that use a vertical
scrollbar for scrolling the window contents.

The IntelliMouse provides an alternative mechanism for scrolling. With the IntelliMouse you can now use your mouse to scroll instead of interacting with the navigation controls on the screen. To scroll with the IntelliMouse, you rotate the wheel control forward or backward, which is equivalent to pressing the up arrow or down arrow on the scrollbar.

The IntelliMouse also supports AutoScroll. To initiate AutoScroll click the mouse wheel, then move the mouse away from the origination point. The contents of the window will start to scroll in the direction you move the mouse. The farther away you move the mouse from the origination point, the faster the contents will scroll. Pressing a key, clicking a mouse button, or rotating the mouse wheel will terminate AutoScroll mode.

You can modify settings for the IntelliMouse through the Control Panel mouse settings. See the Microsoft documentation for more information about the IntelliMouse.

**Rich Text Format Support**

The SAS System provides two TrueType fixed pitch fonts: SAS Monospace and SAS Monospace Bold. These fonts contain several extended ASCII line drawing characters in positions that are normally undefined in an ANSI font. Using these line drawing characters with the TABULATE procedure provides a smooth line drawing capability resulting in tabular output that is more visually appealing.

The Sasfont bitmap font displays faster and looks better on the display, so it is the default display font when you install the SAS System. The SAS Monospace font looks better in printed output and scales to many point sizes, so it is the default printer font. For similar reasons, the SAS Monospace font is the default font used in the Rich Text Format (RTF) clipboard format. The RTF clipboard format, available since 6.11, allows you to copy selected text and tables to the clipboard and to paste them into other applications while preserving the correct appearance. This allows you to copy a table generated by PROC Tabulate into Microsoft Word to produce an aligned table in the Word document. RTF uses the SAS Monospace TrueType font when the default display font is either Sasfont or SAS Monospace. Otherwise, RTF uses the default display font.

You can use the Save As dialog to create RTF files containing the content of text windows. The command, `WRTFSAVE`, saves the contents of the current text window to an RTF file.

**HTML support**

With this version the SAS System can also generate output in HTML format. Please refer to the paper "ODS for Data Analysis Output As-You-Like it in Version 7" in these proceedings for more information about how to accomplish this with the SAS System.

**Preferences**

Additional preference settings have been added to give users more control of the SAS System environment. The Preferences dialog has also been updated to use a tabbed dialog to categorize settings.
See the Preferences snapshot below with the Advanced Tab selected.

![Preferences snapshot](image)

Some of the new preference settings are listed below:

**Hide cursor in non-input windows**
Enabling this setting suppresses the display of the cursor in SAS windows that do not allow text input.

**Disable scrollbar focus**
Enabling this setting prevents scrollbars that exist internal to the window dressing from getting focus. This prevents the flashing thumb bar that sometimes occurs in windows that use scrollbars in this way.

**Save settings on exit**
This option is TRUE by default and causes the saving of window placement settings when you exit the SAS System.

**Open and Save As Dialogs**
In previous releases of the SAS System filetypes and filenames for the Open and Save As dialogs were associated with the dialog instead of the active window. With this version filetypes and filenames are associated with the window that invokes the dialog. These changes allow the window that invokes the dialog to set the default filetype and filename.

The **DLGOPEN** command has been enhanced to extend support for long filenames. The previous format of the command did not support complex filters. Complex filters include filters with spaces and apostrophes. The enhanced syntax is:

```
DLGOPEN longfilter = "a b.sas|b’s.sas"
```

**Menu Changes**
The menus in Version 7 have been redesigned to be more compatible with Microsoft Office applications. The most obvious change is the removal of the **Options** menu item and the addition of the **Tools** menu item. Most items from the **Options** menu now exist on the **Tools** menu. Below is a picture of the new **Tools** menu.

![Tools menu](image)

**Improved Help**
The SAS System help facility uses HTML help for this version. Some of the documentation available in this format includes usage notes, the SAS sample programs, the Windows companion, and the SAS System requirements.
Font Scripting
The capability to specify the script (codepage) to be used with a font is a new feature in Version 7. This feature allows you to use fonts that have codepages other than the default codepage currently in use by the SAS System. This feature is useful for international users of the SAS System or users that use more than one character set at a time. For example, users can now create SAS/AF\textsuperscript{®} FRAME entries that use a Cyrillic, Greek, and Western European font at the same time.

OLE/ActiveX
OLE 2.0, which the SAS System has supported since Release 6.10, provides many features that you can use to enhance your SAS/AF FRAME entries and SAS/EIS\textsuperscript{®} applications. The SAS System OLE support consists of OLE container (including support for ActiveX controls), OLE automation controller, and OLE automation server. For a more in-depth description of the OLE support available in the SAS System, refer to the paper “OLE and the SAS System for Windows Release 6.12”.

To enhance our support of OLE we have added two new features in Version 7. Both of these features extend our OLE automation controller support. First, we now support multi-dimensional arrays when using the automation controller within SAS/AF. This support provides a significant performance improvement when accessing large amounts of data from other OLE servers.

The second feature we added is support for automating an OLE server on a remote machine using DCOM (distributed common object model). With this functionality you could access Microsoft Excel data that exists on someone else’s machine and use it within your SAS/AF PROGRAM.

To use DCOM you must run the dcomcnfg utility on the remote machine to set up permissions to run applications. Please refer to the DCOM help topic available with the Windows System for more information.

APPLICATION INTEGRATION
The Version 7 SAS System continues the evolution of the SAS System’s integration with other applications. In addition to communications possible with pipes, DDE, and external DLL access, more support is now available in the areas of e-mail, Lotus Notes, ODBC, and the SAS System Viewer.

E-Mail and Lotus Notes
First seen as an experimental feature in the 6.12 SAS System, SMTP (Simple Mail Transfer Protocol) support is production in the Version 7 system. SMTP e-mail allows direct communication with SMTP mail servers across a network. This type of mail server is common in mixed networks that include both PCs and UNIX systems. A benefit of SMTP e-mail is that it requires no client software (other than TCP/IP networking).

Other enhancements to e-mail include added support for Microsoft Exchange Server. For organizations that use Exchange Server for e-mail and groupware information sharing, information can be posted directly to public folders. By posting to public folders, automated SAS programs can direct their output (such as
nightly reports) to standard locations for access by other users.

Lotus Notes support has been improved at user request to allow the export of SAS System output with formatting information such as line breaks retained. Report output can now be directly exported to Lotus Notes for groupware sharing without changing the report format generated by the SAS System.

**Universal ODBC Driver**

The Universal ODBC Driver allows other applications to access SAS data without requiring access to the SAS System. This driver is new since 6.12 and supplements the basic SAS ODBC Driver that provides ODBC data access through the Base SAS System. While the SAS ODBC Driver provided both read and write access to data through the SAS System, the Universal driver provides read-only access.

This driver is significant because it allows other applications, such as Microsoft Excel, to directly access data stored in SAS formats without requiring the SAS application software. For organizations storing large amounts of SAS data on PC networks, this driver opens up the server data to more applications than ever before.

The Universal ODBC Driver is sold separately and operates only on Windows platforms. The driver provides access to the standard data sources, including: SAS data sets, CFO Vision Financial Database (FDB) files, SAS multi-dimensional database (MDDB) files, and JMP files. The Universal ODBC Driver also supports access to SAS data generated on other platforms, such as UNIX or OpenVMS.

**SAS System Viewer**

The SAS System Viewer has been enhanced to accompany the Version 7 SAS System. In addition to supporting both Release 6 and Version 7 SAS data formats, it has enhancements in several areas.

**Active Document Support**

The SAS System Viewer can be embedded within other applications (such as a web browser) to provide a more consistent interface across applications.

**Automation Server Support**

The Viewer is controllable through an object model so that other programs can access data through it. While more limited than ODBC, this provides a basic data access method for VB and Visual C++ programmers. In addition, Java or VB script users can control some aspects of Viewer operation.

**Improved Printing Support**

The Viewer now handles pagination embedded in SAS System output files. When these types of files are browsed, they can be correctly viewed and printed.

**Workbook View Support**

When viewing multiple windows simultaneously, the Viewer allows the selection of a tabbed workbook view to facilitate navigation.

**Data Subsetting Support**

To facilitate the viewing of very large SAS data sets, the Viewer can be configured to subset the number of observations being viewed. This allows much
larger data files to be viewed without exhausting system memory.

Quick Viewer Support
In addition to operating as a separate program, the SAS System Viewer can be used as a component of the QuickView application distributed with Windows 95 and Windows NT. Within this application, SAS System data can be browsed in the same way other program data can be quickly perused.

Please refer to the paper, “Integrating Windows Clients and the SAS System into the Enterprise” (also in these Proceedings) for more details on application integration features.

SETUP ENHANCEMENTS

The basic operation of the SAS System Setup program has been enhanced in a number of areas.

Silent (unattended) Setup improvements
Setup now works better in unattended mode, and is able to be used with Microsoft Systems Management Server for remote, unattended installations.

Multiple user support
To facilitate multiple users on the same computer, Setup defaults to allow users to use separate SASUSER and SASWORK locations. By placing these folders in locations separate from the main SAS System image, network installations can be more easily shared, and NT users can avoid conflict between users of the SASUSER folder.

CD Browser enhancements
The Auto-run program launched when the SAS System CD-ROM is inserted has been enhanced, and Microsoft Internet Explorer 4.0 (IE4) users also see a custom web view of the SAS System CD-ROM that facilitates use with IE4.

Multiple installation support
Setup now handles separate invocations, and a single uninstall will correctly remove all previously installed SAS System files.

New dialog selections
In response to user suggestions, the Setup dialogs have been reorganized so that Personal, Client, and Server installations can be more easily selected and performed.

Better network performance
SAS System configuration information is more optimally organized so that performance across a network is improved.

Please refer to the paper, “Taking Advantage of the SAS System on Windows NT” (also in these Proceedings) for more details on NT-specific features available in Version 7 of the SAS System.

OPERATION ON WINDOWS NT

In addition to benefiting from Windows NT-specific features, such as the 64-bit capabilities of NTFS and SMP (symmetric multi-processing) support, the Version 7 SAS System takes advantage of several other capabilities on the Windows NT platform.

BackOffice™ Logo Certification
First received as a post-6.12
production release addition, this logo states that the SAS System was designed for and integrates well with the family of BackOffice applications. This logo indicates that the SAS System supports the NT security model for filesystem and SAS/CONNECT® access. SAS/SHARE® is also administered as a Windows NT Service (along with SAS/CONNECT) and remote unattended installation is possible.

**NT-specific performance enhancements**
The Version 7 SAS System takes advantage of NT features that improve the performance of input and output on the NT platform. These include optimizations for both sequential and random I/O, and are most beneficial when operating on large amounts of data stored on Windows NT Server. In addition, SAS System executable images are “based” to allow optimal loading in NT’s virtual memory space to provide faster load times.

**NT monitoring tools**
The Version 7 SAS System takes advantage of Windows NT system utilities, such as Performance Monitor and Event Log, for more accurate diagnostics and monitoring when deployed in a distributed server environment.

**More 64-bit file system support**
More procedures in the Version 7 SAS System take advantage of 64-bit filesystem support available under NTFS.

**Higher RAM limits**
Version 7 of the SAS System takes advantage of “Four Gigabyte Tuning” available in Windows NT Server 4.0, Enterprise Edition. This allows SAS System applications requiring large amounts of virtual memory to directly access up to three gigabytes of RAM in large server systems.

**Microsoft Management Console (MMC) Version 7**
Version 7 takes advantage of MMC to provide a unified interface for SAS System management functions.

**Microsoft System Management Server (SMS) Support**
Version 7 takes advantage of SMS to provide remote, unattended installation of the SAS System. For organizations utilizing SMS, this greatly facilitates the distribution of software during installation time, as well as for updates.

**SAS/SHARE Service**
New since 6.12, this service allows SAS/SHARE to be started in unattended mode when Windows NT starts. As a service, this also means that SAS/SHARE servers can be remotely administered (started or shut down) from other NT machines on a network.

Please refer to the paper, “Taking Advantage of the SAS System on Windows NT” (also in these Proceedings) for more details on NT-specific features available in the Version 7 SAS System.

**CONCLUSIONS**
This paper summarized some of the many features available in Version 7 of the SAS System. Enhancements in the user interface, Windows integration, and setup program areas continue to move the SAS System into the future. Taking advantage of the capabilities of Windows NT is just another way in which we are
trying to deliver a solid Windows application.

REFERENCES


SAS, SAS/ACCESS, SAS/AF, SAS/EIS, SAS/CONNECT, SAS/SHARE, and SAS/SHARE*NET are registered trademarks or trademarks of SAS Institute Inc. in the USA and other countries.

Other brand or product names are registered trademarks or trademarks of their respective companies.

Author Information:
Jennifer Clegg
SAS Institute Inc.
SAS Campus Drive
Cary, NC 27513
(919) 677-8000
e-mail: jbc@unx.sas.com

Gary Mehler
SAS Institute Inc.
SAS Campus Drive
Cary, NC 27513
(919) 677-8000
e-mail: gjm@unx.sas.com